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Introduction

The AVANT Audiometer series represents a new era of ultra-compact diagnostic audiometry
for your office. Compact yet rugged, this PC-Based system is USB powered and supports
current ANSI and IEC audiometric tests. This manual assumes that the system
hardware, software and drivers are installed and working properly. Please refer to
the MedRx AVANT Audiometer Installation Manual for assistance. The Installation Manual is
included in the original AVANT Audiometer packaging in both printed and PDF formats.

The scope of this manual is to get you “up and running” with your AVANT Audiometer
System. Please consult the interactive Help System within the software for more detailed
information of features and functionality. To access this tool, press the F1 key at any time, or
click the Help icon or text menu with your mouse. Access these by clicking on the “Help” tab
at the top of the screen, and select “Help Topics”. Select an item from the list in the Index tab
and click “Display”.
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The AVANT Audiometer Software Qverview

The AVANT Audiometer software can run stand-alone or from NOAH™ System or the TIMS®
NOAH-Compatible Office System.

Launching the AVANT Audiometer Software
Stand Alone NOAH

o
A
favamll AVANT

Y .
vant Noah 4 \_ 4 AUDIONETER
« Double Click the AVANT e Launch NOAH. _
Audiometer shortcut on your e Launch Avant Audiometer module
Windows Desktop. following NOAH procedures.

Basic Software Options

Several options are available which allow the user to customize the AVANT Audiometer
Software to meet their needs.

Access these options from the File Menuon  The Options may also be accessed

the AVANT Audiometer Main Screen as from the Audio screen by clicking on
shown below. the Options text menu as shown
. below.
m Functicn Help o ) -
Pt Setup... b Eile Fupction Ear Output Audie Stimulus
Page Setup... Andiomety SRT Wh Shenger

Clear Session Data

Advanced Options...

Exit
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rOpt]ons u ropﬁons u

View | Audiometry | MHAMLS | Tymp | View  Audiomety | MHA/MLS | Tymp |
Amow Buttons ————————————
~Plgt ————————————————— Speech Spectum ——————— Default Level {dB): |35 'l
P [ Canos Move Up by {dB): IE 3
¥ Horizontal Grid ¥ Speech Sounds Hove Donn by €B): 10 = e e -
~Sight ——————— Language: ' Auto Sound Defautt Tone: IContinuous vl
Style: Il_ines Vl <Default> -
I au _I I™" Reverse Keyboard Amows Speech Scoring: IStandard 'l
Size: IED Fort Size: |12 'l I l
Default Speech Input: |File hd
I~ Reverse Level Controls

¥ Dual Plot Mode Defautt Ear: Inght vI Level Unit ¥ Auto Advance Words, Limit: |25 VI
@ 5B 1dB
I Reverse Ears Plot Curves With: [Medium =]
|¥ Enable Operator Headsst
¥ Maintain Plot Ratios V¥ Use Plot Artigliasing [V Enable Talkback Microphone
oK | Cacd | Hep | 0K | Cancel | Heb |

The View tab allows you to set the default The Audiometry tab sets the look and
appearance of the test environment. behavior of the audiometer.

rOpt]cms ﬂ rOpt]cms u

View | Audiometry MHA/HLS | Tymp | View | Audiometry | MHA/HLS  Tyme |

~ MHA

Output: .Nr Conduction - 1 'l Scear |3'D ce jv

Defautt Level: |5ﬂI _,;' [V Auto Switch Modes

MHA Simulation: INorrnaI vI ¥ Interpalate Curve

[ Allow Muttiple Records

~HLS

Output: [Free Field - Line Out ~|

Default Level: Ifﬂ _I::
HLS Simulation: INorrnaI 'I

0K | Cancel | Hep | ok | Cancel | Hep |

The MHA/HLS tab sets the default look and If your system has a Tympanometer
behavior of the Master Hearing Aid and connected, this tab will assist in configuring
Hearing Loss Simulator. the look of the display.

NOTE: Remember, more information is always available in the Interactive Help System by
clicking the Help Icon or pressing the F1 key.
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Assign Transducers

Option 1: On the Audiometry Options
screen click Transducers to assign specific
transducers to the audiometer outputs.

=e Words, Limit: |25 "I
;

Sancel | Hep |

Option 2: You can change transducers by

Right-Clicking on any transducer icon on
the Audiometry screen.

€q o

ADT mue

Ll T 000,

Change Transducer

Mask With

Close

The Transducers dialog box will then appear. Select the appropriate transducer for each

output.

Headset AC-1: IEAF'. Tone

Headset AC-2: |TDH39

Bone Conductor:

Outputs

Enable Outputs

Select Enabled Outputs:

[w] Air Conduction - 1

[w] Air Conduction - 2
[w|Bone Conduction

[w|Free Field - Line Qut
[v|Free Field - Loudspeakers

o]

Cancel

To add or remove outputs, Click Outputs to enable or disable transducer buttons on the

D-0117967-B 01/2019
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Advanced Options

—
m Functicn
Print Setup...
Page Setup...

Help

Clear Session Data

Options...

Advanced Options...

Exit

The Advanced Options screen allows you to
configure your system to meet your individual
clinical needs. It also provides MedRx
Technical Support with tools for helping you
troubleshoot technical issues. Access this
screen from the File Menu on the Avant Main
Screen as shown to the right.

The key features of each tab are described below. For more in-depth information, consult the

Advanced Options

General ]Aud\n ] Video ] Tympannmetrﬂ

CD-ROM Drive: |D: hd

I Widitile fonitors

I Home Directory Calibration Data
Language
Device Manager
Control Panel
System Information
0K | cancel ‘ Help |

The General Tab configures the overall
AVANT Audiometer behavior with respect to
other Windows programs, specifically NOAH.

B

Advanced Options

Genemll Audio  Video ]Tympanumetrﬂ

Otoscope Input
Device: R - |

Altemative Input

Device j

o |

If your system has a Video Otoscope, the
Video tab allows you to select the
appropriate device driver.

Cancel | Help |

D-0117967-B 01/2019

interactive Help system within the software by pressing the F1 key or clicking the Help icon.

Advanced Options

General Audio 1 Video 1 Tympanumary]
(o1 W - Speakers (2- USB Audio Device) - AZD+ hd
Input Device: |L|ne (2- USB Audio Device) - AZD+ j
Output Mixer: [2- USB Audio Device -l
Input Mixer: |2— USB Audio Device ﬂ
Microphone Gain (dB): |12 Set Defaults ‘ Audio Properties |

oK Cancel | Hep |

Use the Audio Tab to select the proper audio
device for your Audiometer. This tab also
provides access to the Windows Audio
controls.

§ 5
Advanced Options léj
Gsneml] Audio ] Video  Tympanometry ]
Tympanometer: | SaEIERE] -
OK Cangel | Help ‘

If your system has a Tympanometer
connected, use this tab to identify it and
ensure the driver and software that control it
are correctly installed.



Preparing for Testing

Use the accessories provided with your Avant Audiometer. Typical acceptable transducers are
shown on the “Transducer & Accessories” page in the Installation manual. Operator headsets
for use with the Avant Audiometer should have 32 ohms impedance and the speaker power
should be at least 50 watts. Air conduction transducers for use with this device should have
an impedance of 10 ohms. The speaker voltage should match the local mains voltage where
the device is used.

The Operator Headset with microphone is used by the device operator to communicate with

the patient. The patient talks to the operator using the Talk-Back microphone.%

Placing the Earphones on the Patient

Insert Earphones

IMPORTANT: The foam tips used for the insert earphones are for SINGLE PATIENT USE ONLY.
Do not attempt to wash and re-use them.

1. Place a new set of foam tips on the earphone tubes as shown.
These tips are designed for single patient use and should not
be washed and reused.

e« NOTE: When removing foam tips after use, be sure the clear
plastic tubing nipple remains attached to the long
earphone tube.

2. Carefully compress the tip between
your fingers to allow it to fit into the
patient’s ear canal as shown. Do not
roll the tip between your fingers.

3. Pull up and back on the patient’s
pinna to straighten the ear canal.

4. Place the compressed foam tip deep
within the ear canal.

5. When properly placed, the outer
surface of the insert tip will be flush
with the opening of the ear canal as
shown.
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Supra-Aural Headphones

1. Place the headphones on the
patient’s head so the center of the
headphone is directly over the
opening of the ear canal.

2. Adjust the headband so the
headphones remain in place, but
be careful not to make it so tight as
to cause patient discomfort.

High Frequency Earphones (HDA 200) *Stealth Only*

NOTE: The HDA 200
Earphones are part of an

1. Place the earphones on the
patient’s head so the center of the

upgrade option for the earphone
AVANT Stealth Audiometer. is directly over the opening of the
If you need to test ear canal.

frequencies beyond 8000
Hz, you must notify MedRx.
This option carries a price
differential which will be
detailed at the time of order.

Adjust the headband so the earphones
remain in place, but be careful not to
make it so tight as to cause patient
discomfort.

Placing the Bone Conductor

1. Locate the mastoid process behind the pinna. This is
the bony shelf just behind where the ear meets the
head.

2. Carefully place the bone conductor on the mastoid
process and hold it in place.

3. Place the headband over the head to the opposite
temple.

4. Carefully and slowly loosen your grip to check if the
bone vibrator and headband will stay in place.

If either moves, reposition until both the headband and
bone vibrator are secure.
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Sound Field Testing

The Sound Field speakers (Free Field) should be connected using optional or user supplied
amplifier and speakers. They should be calibrated annually as per ISO 8253-2, located at least

1 meter from the patient ear and at the same height.

Device Maintenance

Annual re-calibration of the transducers used with the Avant Audiometer is recommended.
There are no user repairable components of this device. Refer to the Installation Manual for

care and cleaning instructions.

Performing Audiometric Testing

The screen shot below shows the controls which are available from the Audiometer main window.

The sections of the manual that follow explain how to use these tools to perform hearing

evaluations using your Audiometer.

File Function Ear ©Output  Audio  Stimulus  Options,.,  Tools  Help

‘ Audiomety ‘ SAT WR ‘ Stenger ‘ ‘ QuickSIN ‘ m o
-
Right Ear
HL[dB) HL[dE ] 500H=z 105dB
i |
o o i
10 10
- h \ th

20 8 T s an \ 2 LD

0 i K 0 i g K

40- o, - ch 2 - dy ch T

50 i i ! o i 0 i ! o T -‘\j\ -

B0 60 ’\:r -

70 70

20 80

a0 30

i P .
100 ] P e O 100 .:r_l/
1o 1o
120 120
125 250 500 750 1k 1.5k 2 3k 4l ;13 125 250 500 750 1k 1.5k 2 3k 4 Bk 8 ‘ )
D
Frequency [Hz | Frequency [Hz |
PTA Lefi: 36dB, PTA Right: 36dB
= # 5AT WR Aided WR MCL ucL
Left:
Right:
Bath: (LR

Test selection tool bar

Ear selection

Output selector

Test Type Selector

Tone Type Selectors

Output Level Potentiometers

Masking interrupter and routing selector

NounkwNn =

D-0117967-B 01/2019

8. No Response button
9. TestInterrupter

10. Back

11. Help

12. Discard

13. Talk Over

14. Legend
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Pure Tone Audiometry

Pure Tone Audiometry measures the patient’s peripheral hearing sensitivity, or the softest
levels they can hear pure tones at a variety of frequencies. These thresholds are plotted on a
standard graph called an audiogram. The AVANT Audiometer software controls the
hardware, stores the data (if running within NOAH or TIMS) and prints a standard audiogram
report. Pure tone Audiometry can be performed via earphones or a Bone Conductor (Bone
Conduction).

Prerequisites:

e Before performing audiometry, careful inspection of the ear canal should be
performed. This is best done with Video Otoscopy. After ensuring the ear canal is clear,
place the appropriate transducer on the patient as shown on page 8 & 9.

Pure Tone Audiometry via Earphones

(IP30 Insert Earphones, Eartone 3A Inserts or Supra-Aural Headphones)

= button on the right side menu bar.

Y

. From the main Audiometer Window, Click the | *

2. By default, the "™ button will be selected once you enter the main Audiometry
Screen. Other default settings (based on typical clinical practice and procedures) are:

Right Ear

AC (Air Conduction)
Tone Stimulus
Continuous Tone

anoTo

3. Instruct the patient that they will hear several very quiet (soft) tones (beeps) and that
they should signal (raise their hand, press the patient response button, etc.) as soon as
they hear it. Itis helpful to also say “even if it seems very far away”.

4. Begin at 1000 Hz in the Right ear (unless the patient reports better hearing in the left ear).

- ] Test
5. Present a tone at 60 dB by pressing the space bar or clicking the [+ button.

6. If the patient does not hear the tone (does not signal), raise the level 5 dB using the up
arrow on your keyboard and present again.

7. Repeat step 6 until the patient signals that they hear the tone.

8. When the patient signals they hear the tone, decrease the level by 10 dB and present the
tone again.

9. Repeat steps 6 through 8 until the patient responds to a tone at the same level 2 times
with the level ascending.

10. Using the right arrow key, change the test frequency to 2000 Hz and repeat steps 5
through 8 to establish the threshold at 2000 Hz.
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NOTE: If the threshold at 2000 Hz is more than 20 dB different (less than or
greater than) the threshold at 1000 Hz, repeat steps 5 through 8 at 1500 Hz
(the “half octave” between 1000 Hz and 2000 Hz).

11. Repeat steps 5 through 8 for 4000 Hz, 8000 Hz, 500 Hz and 250 Hz.
12. Repeat steps 5 through 11 in the opposite ear.

NOTE: The software automatically calculates the 3-frequency Pure Tone Average
(PTA) which is displayed above and inside the legend as follows:

PTA Right: 60dB

Air Conduction, A=0%, PTA=SG0

Pure Tone Audiometry via the Bone Conductor

1. Following the instructions on page 9, place the Bone Conductor on the mastoid
process behind the ear with better air conduction thresholds as measured above. If
the thresholds are equal, place the Bone Conductor on the mastoid process behind
the right ear.

2. Establish bone conduction thresholds as described above (see page 11, steps 5-8) for
1000 Hz, 2000 Hz, 4000 Hz, 500 Hz and 250 Hz.

3. Ifthe Bone Conduction (BC) threshold at a given frequency is less (better) than the Air
Conduction (AC) threshold by 15 dB or more, you must confirm the threshold by
performing masking.
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Masking for Pure Tone Audiometry

There are several accepted methods for masking. This manual will not promote one over
another, however, to use the masking function on the AVANT Audiometer, follow the steps

below:

@ Masking bt
[
bt

Test hask
85dE || 50dE

i

B +h || B +h

| @  Mazking | ‘T}‘

v Opposite Ear

Same Ear
Both Ears

v Marrow Band Moise
Speech Weighted Moise
White Moise

v EARTone
TOH39
BC
FF

Close

D-0117967-B 01/2019

Click the Masking button. The red light will
appear indicating that the masking is on.

Use your mouse to adjust the Masking Level
slider shown on the left to the appropriate
level based on your preferred method of
masking.

If you wish to maintain the balance of signal
and masking (for example, masking always
30 dB above the signal), Click the Lock
button after setting the masking and signal
levels.

. The default for pure tone audiometry is to

deliver narrow band masking to the ear
opposite the test ear. If you wish to use a
different stimulus, or route the masking to
the same or both ears, Click on the arrow to
the right of the Masking On button.

Use your mouse to select the new masking
type and routing for your specific
application.

. When you are finished making changes to

the Masking, Click Close.
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Optional High Frequency Audiometry

The AVANT Stealth Audiometer is available with the option to perform extended range
high frequency pure tone audiometry. This is used clinically to evaluate noise induced
hearing loss, ototoxicity and tinnitus. High frequency testing uses the same procedure as
described on page 13 for pure tone audiometry.

To start High Frequency audiometry, select a transducer that
supports high frequencies, such as the HDA 300.

Momnal || Ful || Hi Freq The High Frequency control will appear on the right panel and
will allow choosing frequency ranges to be shown on the plot.
The power supply must be connected to activate the high
frequency control or when using the free field ampilifier.

NOTE: Extended High Frequency Audiometry is an upgrade option for the AVANT Stealth
Audiometer Only. If the high frequency control selectors do not appear on the right panel and
if you need to test frequencies beyond 8000 Hz, you must notify MedRx. This option carries a
price differential which will be detailed at the time of order.

Speech Audiometry

Speech audiometry evaluates how well the patient can hear and understand speech. The
typical test battery includes tests of speech threshold and tests of speech discrimination.

The sections below detail how to perform these tests on the AVANT Audiometer.

Speech Reception Threshold (SRT)

The Speech Reception Threshold (SRT) is defined as the lowest level at which the patient can
repeat Spondee words with 50% accuracy. Spondee words are two syllable words with equal
vocal emphasis on each syllable such as “baseball” or “hotdog.”

Instruct the patient that they will hear a series of two-syllable words that will get quieter as
the test progresses. They are to repeat the words as best they can, even if they sound very far
away. If they are not sure of a word, they should take a guess.

SRT is typically started 10-20 dB more or less than the patient’s Pure Tone Average, which is
displayed on the lower left of the screen. Set the level of the test signal to 10 dB above the
PTA and follow the steps below.

1. From the Avant Audiometer main
screen, Click the Audiometry
button.

2. (lick the SRT button located on the

SRT
s toolbar on the top of the screen.
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| viford List %J 3. Click the Word List button.
ar I

= ) 4. Select Spondee Word Lists A&B
== from the list.

ee Word List ARB
Children’s Spondee Word List

nEe 5. Click Start Test.

PBK-50 List 2 Form A

Start Test Cancel Help

E:;z'cgk 6. Click the Play button or press the F9
sunset key to present a word. The word will
duck pond

cowboy play through the chosen transducer
inkwell .

bl as well as display on the screen.
whitewazh

Datrqeal

:

e

3

% Seoe | B0%Z 7. If the patient correctly re_peats the
word, click the Correct icon or
press F7.

|

Comect | |

- Start Signal

Tota B
Comeck: | 3
3

Incorect: 8. If the patient incorrectly repeats the

word, click the Incorrect icon or
press F8.

Note that the score is calculated and displayed automatically.

If the patient exceeds a 50% score at a given presentation level, stop the test and decrease
the level by 10 dB and repeat the steps above.

If the patient fails to achieve a 50% score after 6 words at a given level, stop the test, raise the
level 5 dB and repeat the steps above.

When the patient scores 50% at a given level, the test is complete. The software
automatically plots the score on the SRT graph.
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Word Recognition (WR)

Word Recognition (WR) is a discrimination, or recognition type test using speech as the
stimulus. WR testing measures the percentage of mono-syllable words repeated correctly
from a phonetically balanced list. Unlike the SRT test, the WR test is performed at a fixed
intensity (dB) level. Typical patients will score their best on WR testing at a level between 35
and 40 dB above their SRT.

Before beginning the test, instruct the patient that they will hear a series of one-syllable
words. They are to repeat the words the best they can. If they are not sure of a word, they

should take a guess.

Wh
“wfard List %
Speach Audiometry =

W-22 List 1 Fom’

W-22 List 2 Form A
W-22 Lst 3 Forn

NU List 1 Form A
NU-6 List 2 Form A
INU-6 List 3 Form A
PBK-50 List 1 Form A
PEK 50 List 2 Form A
PBK-50 List 3 Form A

Play

# Soore;
Tatal:

Comect | |
Correct:
Start Signal Incorect;

1.

From the Avant main screen, Click
the Audiometry button.

Click the WR button located on the
toolbar on the top of the screen.

Click the Word List button.

Select the desired Word List from
the list. The W-22 or NU-6 lists are
good choices for typical adult
patients. When testing children, the
PBK lists should be used.

Click Start Test.

Click the Play button or press the F9
key to present a word. The word will
play through the chosen transducer
as well as display on the screen.

If the patient correctly repeats the
word, click the Correct icon or
press F7.

If the patient incorrectly repeats the
word, click the Incorrect icon or
press F8.

NOTE: that the score is calculated and displayed automatically. The test is complete when all
words in the list have been presented. The software automatically plots the score on the WR

graph.

BE

D-0117967-B 01/2019

9.

Click the Advance button >>or
press the F10 key to present the
next word. Score accordingly as
described above.
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QuickSIN (Optional)

The primary complaint of hearing-impaired persons is difficulty hearing in background noise.
The measurement of SNR loss (signal-to-noise ratio loss) is important because speech
understanding in noise cannot be reliably predicted from the pure tone audiogram (Killion &
Niquette, 2000).

The QuickSIN test was developed to:
1. Provide a one-minute estimate of SNR loss.
2. Provide a quick way for clinicians to quantify a patient’s ability to hear in noise.

3. Determine if extended high frequency emphasis improves or degrades understanding
of speech in noise.

4. Assist professionals in choosing appropriate amplification and other assistive
technologies.

5. Demonstrate that hearing aids with directional microphones improve speech
intelligibility in noise.

6. Provide a large number of equivalent test lists for use in clinical and research work.
7. Provide information useful in counseling patients regarding realistic expectations.

The screenshot below shows the key features of the QuickSIN

test.
1. Calibration Button 4. List Selector
2. Ear Selector 5. Track Display
3. Output Selector 6. Track Control
7. Test Type Selector
I R it G D ~— U e—— . ~—— $ il
PP | IR | | R | - o - O
List1 e ’ $-
T}acks . SN Score - @ i 'f‘ "g‘
T . : —
3. Foolprints showed the path he took up the beach SIN 15 ) @ ARl
+ 4 A vent near the edge brought in fresh air @ SN 10 &
R e T = : ’
- = - 2
255-TOTAL= 255 SNR loss @
Select a sentence... Score :, @ =
L] X =

PR ———
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Performing the QuickSIN Test

e From the Avant main = | e Clickthe QuickSIN
screen, click the e button on the top of
fudenge Audiometry icon. Stenger QuickSIN the Audiometry
screen.

Present the test with earphones or in a sound field. The attenuator dial is set to 70 dB HL. For subjects with
PTA hearing losses greater than 45 dB HL, the attenuator dial is set to a level that is “loud but OK.”, this is
done by the program using the MCL value. A warning legend at the bottom of the window is shown if PTA
is not available. Instruct the patient to repeat the sentences spoken by the target (female) talker. When
testing in a sound field, have the patient hold the talkback microphone close enough so that responses are
clearly audible to the tester.

Latd 1. Select a list from the List
e Selection Window one of
e the following two ways:
List 7
s
List 3 . .
Lit 10 e C(lick the list, then click Select.
List 12
e Or Double-Click the list number.
Select
QuickSIM HFE
mat s 2. Play the first sentence in the
BY' A whte sk jcket goes wihany shoes—————————— NEE list by clicking the Play
1! 2. The child crawled into the dense grass SIN 20
© 3 Footprints showed the path he took up the beach SIN 15 button.
1! 4_A vent near the edge brought in fresh air S/N 10 .
9 5. Itis a band of steel three inches wide SIN 05 Ask the patlent to repeat
21 6. The weight of the package was seen in the high scale SIN 00
the sentence.
<< Play >>
ekl = 3. Score the patient’s response
Tracks SIN Score ot .
1y 2. The child crawled into the dense grass SIN 20 4 one Of the f0| |OW|ng WayS:
14 3. Footprints showed the path he took up the beach SIN 15 3
14 4. A vent near the edge brought in fresh air SIN 10 3 .
2} 5. It is a band of steel three inches wide SINOS 2 e Clickthe check-box of each
B Tre woign o e prakage was seen e mgnsoue ———— [ETTRRINS correct key word with your
<< Play >> mouse. This will record the
25.5 - TOTAL= 7.5 SNR loss (Average SNR loss = 7.50) total number of correct key
Moderate SNR loss. Directional Micropheones help. Consider array mic. words in the score pU”-dOWﬂ.
The weight of the package was seen in the high scale Score
r IR r rr - e Record the total number of
‘ | correct key words using the
Lett Right .
List1; Unaided: AC; Level=70 dB; SMR loss=7.50 dB score pu”-down or by pUShIng

1-5 key on the keyboard.

4. Click the next sentence and then
click Play or click >>. This will
advance & play.
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List 1

Tracks

SIN

Score lﬂ

<l 2. The child crawled into the dense grass SIN 20
1)y 3. Footprints showed the path he took up the beach SIN 15
< 4. A vent near the edge brought in fresh air SIN 10
<y 5. Itis a band of steel three inches wide SIN 05

6. The weight of the package was seen in the high scale SIN 00
<< Play >>

25.5 - TOTAL= 10.5 SNR loss (Average SNR loss = 10.50)

Moderate SNR loss. Directional Microphones help. Consider array mic.

The weight of the package was seen in the high scale

] | | ] |

Tinnometer (Optional)

Purpose of the Tinnometer

PR
el

Score

5. Repeat steps 2-4 until all 6
sentences in the list have been
played and scored.

6.

After all six sentences are
scored, the following
results are displayed:

e Total SNR Loss in dB.
e Recommendations.

Tinnitus is experienced by millions of people worldwide. The Tinnometer is designed to
mimic the sounds of tinnitus in order to provide an accurate and flexible tinnitus assessment.
Tinnitus Assessment increases patient rapport with the clinician when an equivalent tinnitus
sound can be created. The Tinnometer can accurately create tinnitus sounds for fast and
reliable tinnitus assessment. All test results should be used to help counsel the patient on

their specific tinnitus and what the assessment has found.

The Tinnometer test was developed to:

1.

2
3.
4

Break away from the traditional limitation of tinnitus assessment with an audiometer

Produce accurate and flexible sounds that mimic patient tinnitus

Provide extended frequency ranges to more accurately match tinnitus sounds

Decrease the time needed to complete a tinnitus assessment

Standardize reporting needed when completing tinnitus assessment

Allow clinicians to save and recall prior tinnitus assessments

Provide general guidelines for implementing results into tinnitus sound therapies
provided by leading hearing aid manufacturers

D-0117967-B 01/2019
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Performing the Tinnometer Testing:

Lt

Tinnometer

Click the Tinnometer button from
the main Avant Audiometer main
screen.

The following screenshot shows the key features of the Tinnometer:

1. Toggle Switch to Start/Stop stimulus 4.

2. Sliders to control frequency,
bandwidth, slope and tempo of the

stimulus 5.

3. Slider to control the intensity of the

stimulus 6.

Buttons used in determining tinnitus
match, threshold and minimum
masking level

Area where description of items will
be displayed

Channels designed to present
multiple types of tinnitus sounds

7. A graphical display of the sounds being played for the patient. Stimulus and
Audiogram (if done within Avant or Noah) are display in dB SPL

® 44 x

1. Patient response switch indicator 4. Undo

2. Patient monitor microphone 5.

Toggle help section

3. Talk forward 6. Return to Avant

D-0117967-B 01/2019
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There are 3 Steps needed for Tinnitus Assessment with the

Tinnometer

1. ldentify patient’s tinnitus by frequency, bandwidth, slope and tempo

2. Lower the identified tinnitus until patient threshold is reached

3. Raise the tinnitus level above the identified tinnitus intensity (widen bandwidth if
needed) until the patient states they no longer hear the tinnitus. Play stimulus for 60

seconds to ensure masking is achieved.

Step 1: Identlfy Patlent’s T|nn|tus

Audio Output |Tnn|tusT | Questionaire  Informati

@8 =
Whistling

Hissing

Buzzing

Humming

Start by selecting the tinnitus type that
has been described by the patient. This is
an approximation of the tinnitus sound
your patient hears. Tinnitus type will
provide a starting frequency, bandwidth
and slope to help speed up testing time.

Use the stimulus start/stop toggle to
present the selected signal to the patient.

20Hz S0Hz 125Hz 250Hz 500Hz 1k

eecy lEl]—

Ilsj ----- [rs-]r/J_JL\\ ﬁ“’@ z°

16k 24k 120
100

3. Use frequency slider to match the
pitch of the patient’s perceived
tinnitus

4. Use volume slider to match patient’s
perceived intensity of tinnitus

5. Adjust bandwidth, slope and tempo
(for pulsating tinnitus or prevention of
adaptation) as needed

D-0117967-B 01/2019

Buttons to allow greater flexibility in
bandwidth and slope of tinnitus.
Allows the addition of high/low
frequency sounds independently
Allows for independent right/left
volume control

Press Tinnitus Level button once the
patient’s tinnitus is matched
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Step 2: Find Identified Tinnitus Threshold

0 - Level
Threshaold

Step 3: Masking Tinnitus for 60 Seconds

Volume .

120
MML

- =
80

60 Tinnitus
Level

40 =

20
0 Level

Threshold

MANIL

b~

Tinnometer Modulation Tab

1.

2

1.

Use down arrow on your keyboard to
lower stimulus until patient states
they are no longer able to hear the
tinnitus.

Click Threshold Level button.

Use volume slider to increase
intensity of the stimulus until the
patient states they are no longer able
to hear their tinnitus.

NOTE: Lower levels of masking may be
achieved by increasing bandwidth of
the masking stimulus. Pulsating the
masking noise can prevent tinnitus
adaptation.

Press the MML button and continue
presenting stimulus until 60 second
countdown ends.

If patient begins to hear their tinnitus
within the 60 seconds, raise intensity
until masking is achieved and repeat
number 2.

The Tinnometer modulation tab is designed to simulate sound generators
when hearing aid demonstrations cannot be performed. The following are

controls used in Modulation.

" |Random
"] Music
Ocean modulatic

-~ @Aﬁﬁ

—li

—l—

1. Type of modulation Sound
2. Speed of modulation

D-0117967-B 01/2019

3.
4.

Frequency of modulation
Modulation volume range
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To use the Modulation features within Tinnometer, you must first complete
the three steps involved with tinnitus assessment. Once tinnitus assessment
is complete, you can use modulation by:

1. Activating the channel in

Channe which the tinnitus
assessment was performed.
06dB 484229 Hz 66dB
E6dB Threshold Level E6dB
451 Relative Tinnitus Level 451
105L Relative MML 105L
Low High
Band 0.15 015
in octave
slope 100 100
in %

2. Enter the modulation tab on
the right side of Tinnometer
software.

["]Random E

[ Music 20 I‘
0

[~1Ocean modulatic

3. Adjust the modulation stimulus with sliders as a counseling tool for the
patient.
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Tinnometer Audiometry Scan

The Tinnometer Scan tab is designed for various forms of air conduction
audiometry. There are three types of audiometry that can be performed with
Tinnometer. You can access the forms of audiometry with the buttons

located by the number 1 in the image below.

‘ Audiogram ‘

BEKEZY

[
Scan |

Tinnometer Residual Inhibition (RI)

The Tinnometer RI tab is designed for Residual Inhibition (RI) testing for a
patient’s tinnitus. The controls in the RI tab are as follows:

e me o am non s & w2 EN 1. Scale from 0-10 of
- tinnitus bothersome
level
nEeee @ 2. Timer to begin
stimulus
- 3. Tracking of patient’s
/-_I\ ’i\ tinnitus bothersome
U level as a function of
o @ L= time
PVEEPEOPOOO® (i
\ \;:m;!sapzs\z %

A complete tinnitus assessment must be performed prior to performing
testing in the RI tab. Once tinnitus assessment testing is completed, optional
residual inhibition testing can be performed with the following steps:

@O 1. Activating the channel in

66dB 484229 Hz ©66dB which the tinnitus
5608 ThresholdLevel 5608 assessment was performed.
43L Relative Tinnitus Level 43L|
10SL Relative MML 105L|

Low High
Band 0.15 0.15
in octave
slope 100 100
in %
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2. Select the RI tab on the
right side of the Tinnometer

:: 1 software.
‘ . . Ask the patient the
n@w

) @ ) R bothersome level of their
OO WHEEO® © 1 tinnitus from 1 to 10 and

mark their response.

4. Click the stop watch to
begin the masking stimulus
(stimulus to play for 60
seconds).

You will hear a masking noise for 1 minute
Then the noise will suddenly stop
The patient will have to redefine his discomfort about every 30 seconds.

5. Stimulus will play for 60 seconds and automatically stop at the 60 second
point.
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PPPOPOODOO®

6. When the stimulus stops the patient must redefine their tinnitus bothersome
level every 30 seconds. The bothersome level should decrease upon the
stimulus stopping and will increase with time.

7. The test continues until the bothersome level returns to pre-test level.

Tinnometer Report Printing

The Tinnometer has four reports available for printing: tinnitus assessment

report, manufacturer guidance report, questionnaire report and a channel

report.

The following are common features found across reports:

QR Sprer e 1. To generate your report,
N[;:u:ut Tinnitus type  Questionaire  Information  Lan se | eCt w p ri nte r.. ” fr‘O m
open o the File menu.
Save I
Manufacturer Guidance  »
Print 4 printer ...

Exit

2. Select the paper style
us you are printing.

3. Confirm all patient

,i\ information is correct.
4. Choose your print
Ei preferences.
5. Change the zoom of your
I:l print preview.
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H 6. Print your Report.

Tinnitus Assessment Report

Tinnitus assessment reports are able to be generated after completing the

three steps to tinnitus assessment. Once all steps are complete you are able
to print a report

Ed“"'sw 1. To generate your tinnitus
Fi 0 t  Tinnitu tionai I i L.
ile NE:IHJU innitus type  Questionaire  Information an assessment report, Select
Open o “printer ...” from the File menu.

Save

Manufacturer Guidance  »
Print v printer ...
Exit

Channel 1 2. The “Channel” reports are the

Al Channels | tinnitus assessment reports.

GrapthhanneI 1 Select the channel used for

Crorh Chamnel 3 testing or All Channels when

Graph Channel 4 multi-channel testing is
completed.

3. Use the drop down box to

T T select a diagnosis for the

T e patient.

Comments dukd characters 4. Comments can be entered in 4
separate lines with a
maximum of 60 characters.

H 5. Print the Report.
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Manufacturer Guidance Report

Manufacturer guidance reports are designed to provide hearing aid sound
therapy guidance to a clinician based on tinnitus assessment results. Sound
therapy is an option to tinnitus treatment. We encourage all clinics to
develop a tinnitus treatment protocol that is in line with their tinnitus
treatment goals. Manufacturer guidance generated by the Tinnometer is
designed to be a starting point in sound therapy and each patient may differ
in preferred sound.

Manufacturer guidance reports are able to be generated after completing the
three steps to tinnitus assessment. Once all three tinnitus assessment steps
are complete you are able to print a report.

© sk spesies 5 USE AT DERE Trroieerl

Qutput  Tinnitus type  Questionaire  Information Li
New
@
Save
Manufacturer Guidance  » Oticon
v

Print Phonak
Exit Signia

Bernafon
Sonic
Beltone

) MedRx - Speakers (3-
Output  Tinnitus type  Questionaire  Information  Lan

Mew
Open

Save

Manufacturer Guidance  »

Print 3 printer ...
Exit

Channel 1

Channel 2
[RURTIC
Hearing Aid Guidance

rerEpC T
Graph Channel 2
Graph Channel 3
Graph Channel 4

HEY 11 Tt g wm
ok d i
sl

rpecied pwr

HEAT AT Tl

T 1D Tt

HET 1% T
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1. Select the manufacturer that

you would like to have printed
in your report.

. To generate your tinnitus

assessment report, select
“printer ...” from the File
menu.

. Select “Hearing Aid Guidance”

from the list of reports.

. Use the drop down box to

select a diagnosis for the
patient.

. Comments can be entered in 4

separate lines with a
maximum of 60 characters.

. Print the report.
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Graph Channel Report

Graph channel reports will print a patient report which displays an image of
the patient’s tinnitus with QR codes for YouTube videos that play a wind

modulation noise nearest to their tinnitus. To generate the report you must:

) ViR - Speakers (3~ USE AGHia DR Ve Ve

Qutput  Tinnitus type  Questionaire  Information  Lan

Mew
Open O

Save

Manufacturer Guidance 3

Print * printer ...
Exit

Channel 1

Channel 2
All Channels

Graph Channel 1
Graph Channel 2
Graph Channel 3
Graph Channel 4

Questionnaire Report

1. To generate your tinnitus

assessment report, select
“printer ...” from the File
menu.

. Select “"Graph Channel” from

the list of reports. Select the
channel number which you
used to match your patient’s
tinnitus sound.

. Print the report.

Questionnaire reports will only show as an option once the questionnaire has
been completed. Once a questionnaire has been completed and you are

ready to print a report you must:

@ Vi - Speskers (- USE AU DBV TrroVEr Ve

Qutput  Tinnitus type  Questionaire  Information  Lan

MNew
Open O

Save

Manufacturer Guidance v

Print 3 printer ...
Exit
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1. To generate your tinnitus

assessment report, select

“printer ...” from the File menu.
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Channel 1 2. Select the name of the

All Charnels questionnaire you want to

Hearing Aid Guidance
Graph Channel 1 i i

Sraph Chamne 1 print from the list of reports.
Graph Channel 3

|THI

3. Print the report.

Hearing Loss Simulator

The Hearing Loss Simulator demonstrates the effect of the client’s hearing loss for the
significant third party. The program attenuates an input signal to simulate the audiogram.
The third party listens to the free field speakers. The third party can hear how their own
voice is distorted by the hearing loss when the Record input option is used.

The Hearing Loss Simulator requires the client’s Audiogram data. This data can be manually
entered in the Audio screen of this or any other task.

How to perform the Hearing Loss Simulator task

1. Select the Hearing Loss Simulator tab on the toolbar.

2. Enter the Audiogram values manually if the data is not automatically imported to this
screen.

3. Select the input signal type: Mic, File or Record. Select the track and the Play button on
the control panel. See below for instructions on how to use the Record option.
The HLS output is directed to the free field loudspeakers.

4. Select Normal to play the input signal as a person with normal hearing would perceive it.
Select Simulated to turn on the simulation of the client's hearing loss. Toggle between
these selections as necessary.

5. The Reset option restores the audiogram to the original state. Use this option if you have
modified the audiogram while in the simulate mode but want to undo the changes. The
changes to the Audiogram that are made on the HLS screen are temporary and will not
affect the client's original audiometry record.

6. A volume control adjustment bar allows modifying the audio for manual adjustment of
the output level of the free field speakers. This allows the practitioner to demonstrate
improvements to hearing loss with amplification or what happens when further hearing
loss occurs.

7. To stop the playback, select the Stop button on the player.

Note: It is recommended you use a variety of tracks from the list to demonstrate the hearing
loss.
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Record Input Option

This option allows recording and play back of the voice of the third party.

Note: The LSM option appears on the bottom half of the display. This is so the unaided and
aided results can be displayed simultaneously for the patient and significant third party.

Master Hearing Aid

Master Hearing Aid is an alternative to using a stock hearing aid to demonstrate the benefits
of amplification to an inexperienced user. The system applies the fitting rules by default to
the patient's audiogram and simulates a hearing aid. The patient listens to this signal through
the headphones. Options for editing the gain applied to the audiogram are provided.

About the Master Hearing Aid Display

The Master Hearing Aid screen displays a graph with dB Gain on the vertical axis and
Frequency in Hz on the horizontal axis. The plot on the graph represents the gain applied to
the patient’s Audiogram. The NAL-RP is applied by default. A new rule can be selected from
the list on the right side of the display. A volume adjustment bar allows for manual
adjustment of the output level. The control panel on the right of the display provides options
for input signal source and the task icons for Normal and Simulate.

The Master Hearing Aid applies gain separately for each ear. If audiogram values are
entered for the left and right ear, the selected fitting rules will be applied to each ear
separately. Different rules may be entered for different ears (i.e. NAL-RP for left ear and
BERGER for right ear). If an audiogram is entered only for one ear, the gain will not be adjusted
for the opposite ear and the sound for that ear will be normal.

If Binaural mode is selected, the sound will be heard from both channels (left and right). If
Monaural mode is selected, the sound will be heard only from the channel corresponding to
the active ear when the channel for the opposite ear will be muted.

Input signal

Live voice (microphone) allows you to use the right probe mic for live speech input to the
headphones. The clinician or significant third party can speak into the microphone for this
activity. Note: there is a processing delay between the input and playback. Make sure that the
client cannot hear the voice directly but only through the headset. If this is not possible, use
the Recorder (describer below) to simulate speech input.

File allows the user to play sound files. The program supports MP3 and WAV files and comes
with a

preset MedRx Sounds Sensations set of files. After the option is activated, use the player panel
to control the playback.

CD allows the user to play music CDs. After the option is activated, use the player panel to

control the playback.
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Record input mode allows the clinician or third party to record a sample of their speech
which can then be replayed for repeat comparisons under different amplification conditions
for the patient. Refer to the interactive Help system by pressing F1 or clicking the Help icon
to learn more about the recorder.

How to use the Master Hearing Aid:

1.
2.

Select the Master Hearing Aid (MHA) icon from the main screen.

Enter the Audiogram values manually if the data is not automatically imported to this
screen.

Select the input signal type: File, CD, Mic, or Record.
Select Monaural or Binaural.

Select the Normal icon which will send the input signal through to the inserts without
modification. The patient is listening to the signal without any amplification benefit.
Select the Simulate icon to modify the input signal according to the selected rule. This
selection allows the patient to hear the benefits of amplification. Toggle between these
two selections as necessary.

If the simulated frequency response needs to be adjusted, based on feedback from the
patient, manually edit the response by clicking on the gain curve at the desired frequency
and new gain level. The gain curve of the selected test ear on the control panel can be
edited. To edit the other ear, click the appropriate test ear icon on the control panel first.

o ] [ Hint: Use the track return icon on the player control panel to

k=1

% il replay one track continuously.

The Reset option restores the rule to the original state. Use this
option if you have modified the rule but want to undo the changes.
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Printing

Printing within the Avant Audiometer software is very simple.

F1=8 Function Ear Output Aud

Open
Save

Clear Session Data

Page Setup...
Print Setup...
Print Preview
Print...

Go Back
Exit

Ctrl-Back
Alt-F4
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From the File menu, click one of the following options:

Page Setup - Allows you to set margin sizes and the
default text header for your reports.

Print Setup - selects the printer you want the report
to be sent to.

Print Preview - Shows you what your report will look
like before you print it.

Print — Sends the report to the printer. This option
opens the Windows Print dialog which allows the user
to select any installed printer and modify the
properties (quality, number of copies, etc.) for the
print job.
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Symbols that may be used:

Read the instruction manuals
for safe usage of the device
(operating instructions)

35C
10C

Temperature limitation

sal

Manufacturer (MedRx)

P

Start (of action)

EC| REP

Authorized Representative
in Europe

90%
I
30%

Humidity Limitation

Caution, General warning sign

Recording
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SN

or SN Indicates that the device
serial number will follow.

R

Type B applied part.
(Type B equipment)

O

Microphone

)

Stop (of action)

=

Special Disposal Required

<

Calibration

D

N

Headphones

CAUTION
For Single Patient Use Only

Read the instruction manuals
for safe usage of the device
(operating instructions)

Class Il equipment

Start (of action)

()

Non-ionizing
electromagnetic radiation

i

Percentile Setup

Loudspeaker (Speaker)

Q

A

Handheld microphone
(Talkback Microphone)
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Limited Warranty

MedRx, Inc warrants this product to be free from defects in material and
workmanship for one year from the time of purchase. If this system fails to
perform as specified during this period, the purchaser is responsible for
calling MedRx at (888) 392-1234 or (727) 584-9600. The company's
representative will advise the owner to either return specific components
or the entire system to:

MedRYx, Inc.
1200 Starkey Road #105
Largo, FL 33771 USA

MedRx will repair or replace any defective devices, fully test the system
and/or components and ship the system promptly back to the owner.
There is no cost for the repair or return shipping, provided the system is
one year old or less and has not been misused, abused or damaged. Such
damage includes, but is not limited to, dropping, exposure to excessive
heat greater than 100°F and water/liquid damage.

Repair or replacement of the system as provided under this warranty is the
sole and exclusive remedy of the purchaser. MedRx shall not be liable for
any consequential or incidental damages or for breach of any express or
implied warranty. Except to the extent of applicable law, any implied war-
ranty, merchantability or fitness of this product is limited to the duration of
this warranty.

MedRx will, at its discretion, service and repair out of warranty products at
the purchaser's request, charging for parts and labor as necessary.

The limited warranty is deemed void if software or hardware is installed on
this product which is not pre-approved by MedRx, Inc. Approved software
includes NOAH" and HIMSA approved hearing aid manufacturer
programming modules for fitting hearing aids.

MedRx, Inc is not responsible for problems resulting from installation of
unapproved software or hardware. In the event of unapproved software or
hardware installed on the system causing a conflict, MedRx will service the
product for a fee to be determined at the time of service.

Any extension of this warranty past the initial one-year warranty is subject
to the following (where applicable).

1. A $300 deductible per repair.

2. Extended warranty does not include cables, connectors or peripherals.
3. Extended warranty of the Video Otoscope covers optics only.
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